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Abstract: Outlook is a messaging and collaboration client for easing the 
task of managing your electronic mail, personal calendar and 
group scheduling.  Personal information such as contacts and 
tasks, custom collaboration and information-sharing applications 
allow a user to keep track of what they are doing.  Outlook helps 
users organize, find and view all of this information — all in one 
place — using a consistent interface. 
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Introduction 
Outlook is an information management program that coordinates email messages, 
calendars, contacts, and tasks.  Outlook communicates with the Exchange server to give 
you the ability to share information with others.  This “Exchange environment” offers 
users sophisticated ways to collaborate such as group scheduling and public folders.  All 
information related to your email is stored on the Exchange server.  This allows you to 
access your email from anywhere there is a network connection. 

Outlook is different than Outlook Express, which is part of Internet Explorer, the popular 
Internet browser.  Outlook Express is limited to email and news such as sending and 
receiving Internet email, maintaining an address book, and communicating with Internet 
newsgroups.  Outlook Express is simpler to set up and use if you only need to read email 
and news.  Outlook, however, has more advanced features such as calendaring, tasks, and 
public folders. 
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With Outlook Web Access, another way to access the KU Exchange server, you can use 
any Web browser to gain secure access to your Exchange account.  KU’s Outlook Web 
Access site is http://www.mail.ku.edu/.  The Web client looks similar to your desktop 
client, with the exception of the Web browser toolbars at the top and bottom of the 
window.  (A copy of the Outlook Web Access handout can be found at: 
http://www.ku.edu/acs/docs.) 

Other client email programs can access email messages stored on the KU Exchange 
server, such as Outlook Express and Eudora.  Using these client email programs only 
gives you access to your mail on the Exchange server, nothing else. 

Objectives 
In this course, participants learn the fundamentals of using Outlook’s email.  Upon 
completion of this course the participants should be able to:  

• navigate the Outlook application window. 

• view and sort email in different ways. 

• create, forward and reply to email messages. 

• send and receive attachments. 

• maintain information about your contacts. 

• use distribution lists to contact a group of people with one email message. 

Although this handout is prepared with Outlook 2002, those using the Outlook 2000 
client should be able to do almost all of the features listed.  If you are interested in 
downloading the Outlook 2002 (for Windows) client, visit 
www.ku.edu/exchange/outlook. 

Prerequisites 
It is assumed that the participants in this workshop know how to use the Windows 95/98 
operating system to maintain files and directories/subdirectories. 

Related Training Available from ACS 
All workshops offered by Academic Computing Services (ACS), a division of 
Information Services, are free to KU students, staff, faculty, and approved affiliates.  

To learn more about or register for workshops, receive automatic announcements of 
upcoming workshops, and track workshops you’ve registered for and have attended, visit 
the ACS Web site at www.ku.edu/acs/train. You can also check our online schedule at 
www.ku.edu/acs/schedule for a list of class offerings and their availability. For further 
workshop related questions, please email training@ku.edu. 
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Definitions 
Term Definition 

Information 
viewer 

The section of an Outlook window displaying a specific type 
of item.  Each folder has an Information viewer that displays 
information regarding that folder. 

Item 
Any piece of information created in Outlook, such as an email 
message, a contact, or an appointment. 

AutoPreview Outlook’s capability to display the first three lines of a 
message without you opening the message. 

Contacts The folder that contains information on your business or 
personal contacts: names, phone numbers, email addresses, 
faxes, and much more. 

Drafts The folder where draft messages are saved.  Outlook 
automatically saves a draft copy of any incomplete message 
every three minutes. 

Global Address 
Book 

This database contains a list of user names, email addresses, 
phone numbers and department information.  The KU global 
address book contains information for faculty and staff on the 
Lawrence campus and at the University of Kansas Medical 
Center.  The Lawrence addresses include everyone on the 
Exchange system and everyone with a registered email 
address. 

InfoBar An informational line that appears below the toolbar on a 
message form.  The InfoBar provides information about what 
has occurred or what the user needs to do with a message.  
When you reply to a message containing an InfoBar, then a 
note appears in the InfoBar indicating the date and time that 
you replied. 

Outbox The folder where messages created offline are stored until 
they are sent.  When they are sent the messages are 
automatically moved to the Sent Items folder. 

Outlook Bar A toolbar that contains shortcuts to frequently used folders in 
Outlook. 

Outlook Web 
Access (OWA) 

Web site accessible with any java-enabled browser that 
provides access to email, calendaring and public folders on 
the Exchange server.  OWA at KU is at 
http://www.mail.ku.edu 
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Preview Pane An area within the Inbox Information viewer that contains 
previews of received messages. 

Sent Items The folder where messages that have been sent are stored.   

Personal 
Distribution Lists 

A distribution list is a collection of contacts.  It provides an 
easy way to send messages to a group of people. When a 
message is sent to a personal distribution list, recipients see 
their own names and the names of all other recipients on the 
To line of the message instead of seeing the name of the 
distribution list.  You maintain this type of distribution list. 

Exchange 
Distribution Lists 

A distribution list is a collection of contacts.  It provides an 
easy way to send messages to a group of people. When a 
message is sent to an Exchange distribution list, recipients 
see the name of the distribution list on the To line of the 
message instead of seeing the names of each individual.  
This type of distribution list is maintained by the Exchange 
Server, making updates automatically on a nightly bases. 
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Outlook window 
When you start Outlook, your Inbox appears listing the email messages you have 
received.  The icons in the vertical Outlook Bar, to the left of the Inbox Information 
viewer, represent shortcuts to frequently used Outlook folders and features.   

  
The Outlook Inbox 

The Outlook Bar provides shortcut icons to your most frequently used folders.  You can 
add, remove, or change the size of a shortcut icon.  Shortcut icons are displayed in groups 
to assist in organizing information.  You can also add or remove groups from the Outlook 
Bar or reorganize them to meet your work patterns.  The default groups include Outlook 
Shortcuts, My Shortcuts, and Other Shortcuts.   

When you choose an icon in the Outlook Bar, Outlook opens the folder associated with 
that icon and displays the items contained in the folder in the Information viewer.   

The Folder List, another way to open a folder, contains Outlook’s default folders, 
personal folders, and Public Folders.  Simply click on the folder name in the Folder List 
and the folder contents appear in the Information viewer. You can easily check the size of 
a folder by right-clicking the folder name, selecting Properties and then clicking Folder 
Size….   

When a folder is opened that folder’s default view appears. Views display information in 
a way that allows the user to quickly evaluate the information in a folder.  Each folder has 
alternate views.  You can select an alternate view for the folder displayed by clicking the 
View menu, pointing to Current View, and then selecting one of the choices from the 
submenu.  In addition to the views supplied by Outlook, you can design your own view. 

Anything created in Outlook is called an item. Each appointment, event, meeting, 
contact, received message, sent message, and so on, is an Outlook item.  Items are stored 

Preview Pane 

Information 
Viewer 

Folder 
Banner 

Outlook Bar 

Folder List 
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in folders.  Outlook displays the items in a folder, which you view with the Information 
viewer.  The Information viewer displays only some of the information for an item.  
Double-click the item to display more detailed information.  When you do so, the item is 
displayed in the form in which it was created or saved.  To return to that folder’s 
Information viewer, click the close button on the window for the item being displayed. 

All of the groups in Outlook work together enabling you to drag-and-drop items from one 
folder to another.  Almost everything in Outlook is customizable by clicking the Tools 
menu and selecting Options…. 

Using the Outlook Bar 
Each Information viewer displays the Outlook Shortcuts Bar at its left edge.  Click the 
shortcut icons in the Outlook Bar to select which Information viewer you want to see.   

Note: If the Outlook Bar is not showing, click the View menu and select 
Outlook Bar.  

The Outlook Bar contains three default groups: Outlook Shortcuts, My Shortcuts, and 
Other Shortcuts.  Only one group displays at a time.  Click the name of the group to 
display that group’s shortcuts.  The Information viewer does not change, only the 
shortcut listing.  The name of each shortcut identifies an Outlook folder.  Click a shortcut 
and the Information viewer changes to show the information contents of that folder. 

Outlook Today 
Outlook is the name of the desktop application.  Outlook Today is the name of the 
Outlook window that displays a summary of the information that’s relevant to today and 
the next few days.  To view the Outlook Today window, click on the Outlook Today 

icon  on the Outlook Shortcuts Bar.   

 
Outlook Today 
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Today’s date appears at the top of the Outlook Today window.  The left side of the 
Outlook Today window shows a list of items on your calendar for today and the next few 
days.  You can click any item on the list to see the details about that item.  There is a list 
of your current tasks with the date each task is due.  You can click any task to see the 
details of that task.  It also shows how many unread messages are in your Inbox folder, 
how many drafts of messages are in your Drafts folder, and how many messages are 
waiting to be sent in your Outbox folder. 

Inbox folder 
Outlook makes it easy to receive incoming email messages and view them by putting 
them into the Inbox.  You can manage email by creating, sending, reading, responding to, 
and forwarding messages from the Inbox.  The number in parenthesis beside the Inbox 
shortcut icon tells you how many unread messages you have.  A message that has not 
been read appears in bold.  A message that has been read appears as regular text.  The 
default Information view for the Inbox is messages with the Preview Pane displayed.   

The Preview Pane allows you to view the entire contents of a message without having to 
open the message.  To view a message in its entirety, double-click the message.   

To adjust the amount of viewable text in the Preview Pane position the mouse pointer on 
the horizontal line that separates the message list and the Preview Pane.  When the mouse 
pointer changes to a two-headed arrow, drag it up or down to display the contents of both 
panes, as you would like them to appear.  You can turn the Preview Pane off by clicking 
the View menu and selecting Preview Pane. 

  
The Inbox Information Viewer and Preview Pane 

Information 
Viewer 
Unread 
messages - 
bold 

Preview 
Pane 
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The Exchange server notifies you immediately of any new messages.  

Note: You can also have Outlook provide a text notification.  Click the Tools 
menu and select Options….  On the Preferences tab, click E-mail 
Options….  Then click Display a notification message when new 
mail arrives.  Click OK until you have closed all the dialog boxes. 

Creating a message 
The new Untitled-Message window is a form you complete for each message you send.  
When you are composing messages, put the most important or compelling information at 
the top of your message.   

1. With the Inbox Information viewer displayed, click New .  A new 
Untitled-Message form appears. 

 
A new message 

2. In the To… field, type the email address of the person to whom you are sending the 
message.  If sending to more than one person, separate the email addresses by 
commas (,) or semicolons (;). (Example:  imajhawk@ku.edu, friend@aol.com) 

Note: You must enter the full Internet address (username@server.com), or 
another Outlook user’s ID (mjones) or full names (Mary Jones).  You 

can also click Address Book  or To…  to select names 
from the KU Global Address List or your Contacts folder. 

Outlook automatically checks the names you type in the To…, Cc…, and Bcc… 
fields against the names in you Contacts folders and the KU Global Address List.  A 
number of things might happen to the name(s) in the To… field. 

• If an exact match is found, the name is underlined.   
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• If multiple matches are found, a red, wavy line appears under the name.  Right-
click on the name to see the matches.   

• If Outlook doesn’t recognize the name or address as being an email address 
(username@server.domain), the name is left as you entered it either without an 
underline or with a wavy red line under it. 

• If it is a name you have used before, Outlook automatically tries to complete the 
email address for you.  You might be provided with more than one option if there 
are several people with the same type of name. 

• If Outlook doesn’t find the person or email address in your Contacts, but does 
recognize the address as being an acceptable Internet email address, Outlook 
simply underlines the address you typed. 

3. Type the names of the people to whom you want to send courtesy copies to in the 
Cc… field.   

Note: The Bcc… (Blind Carbon Copy) field is where you enter names of 
recipients who will receive a copy of a message but whose address 
will not appear in the list of message recipients.  To view the Bcc… 
field, click the View menu and select Bcc Field. 

4. In the Subject: field, type a brief, informative description for your message.  When 
you tab to the next field, the Message Window’s title bar changes to reflect what you 
typed in the subject field. 

5. In the large blank area, type your message.  Outlook allows you to format the text of 
your messages. 

Note: If you type a web address (http://www.ku.edu or www.ku.edu), 
Outlook automatically creates a hyperlink in the Windows version.  
The hyperlink text appears blue and underlined. 

6. To add an attachment to the message, click Insert File .  The Insert File dialog 
box appears listing the contents of the My Documents folder.  Locate and select the 
file you want to send with the email and click Insert.  An icon with the filename you 
selected appears in the message at the point of the cursor. 

7. If you want to assign a Contact or a Category to the message, click Options… 

 on the toolbar.  From the Message Options dialog box you can: 

• Click Contacts… to assign a contact whether the message is addressed to them 
or not. 

• Click Categories… to assign as many categories you’d like to the message. 

• Click Close to return to the message form. 

Note: Under the Options section, you have several other options for marking 
outgoing messages.   

• Message Importance.  This helps the recipient(s) of your 
message(s) determine when they need to read and/or respond to 
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the message.  You can send messages marked as High, Normal, or 
Low importance.  The default is Normal. 

• Message Sensitivity.  You can mark a message with one of four 
sensitivity levels to help the recipient know if the message needs 
special handling.  You can mark messages as Normal, Personal, 
Private, or Confidential.  The default is Normal. 

• Voting.  Incorporate voting buttons into messages you send.  For 
example, query people as to whether or not they would like a 
review session on next year’s budget changes and have them use 
voting buttons to return answers to you.  The recipient must view 
the message containing voting buttons is a separate window in 
order to view the buttons.  A special notice appears in the Preview 
Pane of the recipient indicating the message contains voting 
buttons. 

• Tracking.  Ask to be notified when the message has been delivered 
or when the message has been read. 

• Delivery Options.  Chose who receives replies to your email (if not 
you), choose where incoming mail is stored, and other options. 

8. When you are done creating the message and ready to send it, click Send . 

Outlook automatically puts a copy of your sent message in your Sent Items folder. 

Replying to a message 
When you respond to another person’s message, you can reply to the sender only or reply 
to all message recipients if the message was sent to others in addition to you.   

1. To reply to only the author, click Reply  or, if the message was sent to 
multiple recipients, you may want to reply to them all by clicking Reply to All 

. 

Tip: When using the Reply to All option, be sure that everyone who 
received the original message really needs to see your reply. 

A message form appears with the following: 

• The sender’s name (and/or all recipients’ names) automatically appears in the 
To… field. 

• The Subject: field of the original message is retained, with the abbreviation 
“RE:” in front of it. 

• The text of the original message is part of the reply. 

• Signatures are not automatically inserted in reply messages but you can add a 
signature to a reply message.  The signature is inserted at the point of the cursor, 
rather than at the end of the text you are replying to.  To insert a signature, make 
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sure the cursor is blinking where you want the signature added; click the Insert 
menu and point on to Signatures, then select a signature from the submenu. 

2. In the message area, type your reply message.  Your reply appears in blue text above 
the original message unless you relocate the cursor.  

3. When you are finished typing your reply, click Send. 

Note: Reply messages do not automatically include file attachment(s) that 
may have been included with the original message.  Outlook simply 
lists the name(s) of the file(s) attached to the original message.  
However, it is possible to attach the original attachment(s) by 
forwarding the message instead of replying.  

Forwarding a message 
When you forward a message, you actually create a new message, which contains a copy 
of the original message and its file attachments if any.  The original message remains in 
your Inbox and a copy of the forwarded message is placed in the Sent Items folder.  You 
can delete the original message or store it in any folder. 

1. Open the message or select it in the message list.   

2. Click Forward .  A message form appears with the following: 

• The Subject: field of the original message is retained, with the abbreviation 
“FW:” in front of it. 

• The text from the original message is part of the message. 

• Signatures are not automatically inserted in forwarded messages, but you can add 
a signature.  The signature is inserted at the point of the cursor, not at the end of 
the original message.   

3. In the To… field, type the name of the person to whom you want to forward the 
message to or open the Address Book to select a name. 

4. In the message area, type your message.  It is a good idea to include your own 
introductory message when forwarding a message. 

5. When you are ready, click Send. 

Tip: You can change how the original message text is displayed when forwarding or 
replying to messages or choose not to include the original message text at all.  
From the Main window, click the Tools menu and select Options….  The 
Preferences tab should be displayed.  Click E-mail Options….  In the “On 
replies and forwards” section, click the down arrow under the “When replying 
to a message” or the “When forwarding the message” fields to select your 
preferred option from the menu. 
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Printing a message 
Printing email messages is very much like printing any other document. 

1. Open the message or select it in the message summary list. 

2. Click the File menu and select Print….  By selecting Print from the File menu, you 
have the ability to change any print options that you want. 

3. After you make any adjustments you want to the Print dialog box, click OK to print 
the message. 

Alternatively: You can open or select the message you want to print and click 

Print .  By using this method, the message is automatically 
printed without showing you the Print dialog box. 

Signatures 
Your messages can be enhanced with a custom signature.  A signature is a block of text 
that contains your name and contact information that can be added to the end of any 
message you send.  Outlook allows you to create and add several different signatures to 
your messages. 

Creating a signature 
1. From the Main window, click the Tools menu and select Options….  The Options 

dialog box appears. 

2. Click the Mail Format tab. 

3. Click Signatures….  The Create Signature dialog box appears listing any signatures 
you may already have created. 

4. Click New… to start the Create New Signature Wizard. 

5. In the Enter a name for your new signature: field, type a name for the new signature. 

6. Click Next.  The Edit Signature dialog box appears.   

7. Type your signature text in the large empty box where the blinking cursor is.  

• To apply text formats, select the text and then click Font.  Click OK when you 
are done changing the Font. 

• To align the signature text or add bullets, select the text and then click 
Paragraph.  Click OK when you are done changing the alignment. 

8. Click Finish.  The Signature Picker dialog box reappears listing the new signature.   

9. Click OK.  The Options dialog box reappears.   

10. On the Mail Format tab, under the Signature section, the Signature for new 
messages: field should list the default signature you want.  If not, click the down 
arrow next to the field to select the signature you want.  If you do not want a 
signature automatically added to new messages, select <None>. 
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11. By default, Outlook does not put signatures at the end of messages you reply to or 
forward.  If you want a signature added automatically to these types of messages, the 
Signature for replies or forwards field should list the signature you want.  If you do 
not want a signature automatically added to new messages, select <None>. 

12. Click OK. 

If you selected a default signature, Outlook automatically includes that signature when 
you open a new Untitled-Message window. 

Manually adding a signature to messages 
You don’t have to have your signature automatically added to all your outgoing 
messages.  You can chose which messages get your signature or not. 

1. Create the message. 

2. When you are ready to add the signature, click Signature  or click the Insert 
menu and point on to Signature. 

3. Select a signature from the submenu. 

4. When you are ready, click Send. 

Editing/Removing a signature 
1. From the Main window, click the Tools menu and select Options….  The Options 

dialog box appears. 

2. Click the Mail Format tab. 

3. Click Signatures….  The Create Signature dialog box appears listing the signatures 
you have created. 

4. Select the signature you want to either edit or remove from the list. 

5. Click Edit… or Remove…, as appropriate. 

• Edit – displays the Edit Signature dialog box allowing you make changes.  

• Remove – warns you about removing the signature.  Click Yes to remove. 

6. Click OK to close the Create Signature dialog box.  If you removed a signature, you 
might want to double-check the Signature for new messages and the Signature for 
replies and forwards fields to be sure it uses the signature of your choice. 

7. Click OK to close the Options dialog box. 

Sharing Files in a Message 
You can share files such as spreadsheets, database files, or word processing files by 
sending them to a user as message file attachments.  You can include a file with your 
message in two ways: attach a file to a message or insert the contents (text only) in a 
message.  If you need to send an attachment to a group of people, it is recommended that 
you use the Public Folders or share it another way than email. 
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Attaching files to a message 
1. Create a message to send. 

2. Click Insert File . 

3. Locate and select the file to be attached.  Click Insert. 

4. An icon with the filename you selected appears in the message at the point of the 
cursor.  

5. Finish the message and click Send when ready. 

Inserting text files in a message 
When you are trying to insert text, Outlook attempts to insert the text from any file it 
recognizes.  Other formats than a straight text file or simple HTML file do not insert 
properly.  If you want to insert a document as a text file, first save it as a .txt or .htm file. 

1. Create a message to send. 

2. Click Insert File . 

3. Locate and select the file to be inserted. 

4. Click the down arrow next to the Insert button. 

5. From the drop-down menu, select Insert as Text.  The text is inserted in the message 
at the point of the cursor. 

6. Finish the message and click Send when ready. 

Viewing an attachment 
To open an attachment you can: 

• Double-click the attachment icon from an open message window or from within the 
preview pane. 

Note: An attachment in a message that uses HTML or plain text as the message 
format appears in a line below the Subject field.  An attachment in a Rick 
Text message or in other types of items is included in the body of the 
message. 

• Right-click the message that contains the attachment.  From the submenu, point on to 
View Attachments; then click the name of the attachment that you want to view. 

Saving an attachment 
You may want to save attachments to your hard drive, a diskette, or maybe a local file 
server.   

1. Open the message with the attachment that you want to save. 

2. Right-click the attachment icon. 

3. From the submenu, select Save As….  The Save Attachment dialog box appears. 



ACS Computer Training 
Outlook: Email Basics  

Academic Computing Services - 16 - © 2004 The University of Kansas 
A Division of Information Services 

4. If necessary, change the location of where to change the attachment by using the 
drop-down menu next to the Save in: field. 

5. In the File name: field, you can rename the attachment if necessary, as well as 
change the file format in the Save as type: field. 

6. Click Save. 

7. Close the message. 

Sent Items folder 
This folder displays the messages you have already sent. 

1. Click the Sent Items folder  to see the messages you have already sent. 

2. To view a message in the Sent Items folder, double-click it.  

Outbox folder 
Messages that cannot be sent because you want to delay delivery of a message, or are 
working offline, are saved in the Outbox.  Messages that you have marked with a delay 
delivery, or you “sent” while offline, will automatically be sent when the date and time 
occur or when you log back onto the network. 

Drafts folder 
If you are in the middle of composing a message and get interrupted, or if you want to 
postpone completing a message until a later time, you can save a message to finish it 
later. 

Note: By default, unsent messages you are working on are saved every three (3) 
minutes. 

With the Message window active, click the File menu and select Save.  You won’t notice 
anything happening but the message is saved to the Draft Items folder. You can continue 
working on the message or close the Message window. 

You can go back to the message at any time to add information, send it, or delete it.  
Simply open the Drafts folder and double-click the message you want to edit, send, or 
delete. 

Deleted Items folder   
The Deleted Items folder stores all deleted items from the Inbox, Calendar, Contacts, 
Tasks, Notes, Outbox, Sent Items, and other mailbox folders you have created.  You can 
delete items you no longer need from any folder.  Deleting items is a two-step process: 
moving the items to the Deleted Items folder and emptying the Deleted Items folder. 

Items are permanently deleted when: 
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• You empty the Deleted Items folder. 

• You manually delete them individually from within the Deleted Items folder. 

After either of these steps has been taken, the item(s) cannot be restored. 

Moving items to the Deleted Items folder 
1. Open the folder containing the item(s) that you want to delete. 

2. Select the item(s) to be deleted. 

Tip: To select more than one item hold down the [CTRL] key as you click the 
next item. 

3. Click Delete  or press the [Delete] key.  When you delete an item from a folder, 
the item is moved to the Deleted Items folder. 

Alternatively: You can delete an item by dragging it to the Deleted Items folder. 

At this point the item is only marked for deletion.  If you close and reopen Outlook, you 
will see that these items have not yet been deleted and are still in the Deleted Items 
folder.  This provides the added feature of being able to restore an item that you decided 
you want.   

Undeleting items 
You can undelete items from the Deleted Items folder before it is emptied. 

1. Open the Deleted Items folder. 

2. Right-click the item you want to undelete. 

3. From the submenu, select Move To Folder. 

4. Select the folder into which to move the deleted file. 

5. Click OK.  The item is moved out of the Deleted Items folder and placed in the 
folder you selected. 

Alternatively: You can also retrieve a deleted item by dragging it from the Deleted 
Items folder to another folder. 

Emptying the Deleted Items folder 
1. To permanently delete all the items from the Deleted Items folder, right-click the 

Deleted Items icon on the Outlook Shortcuts Bar. 

2. From the submenu, select Empty “Deleted Items” folder. 

3. A message appears asking you to confirm deletion of all the items in the Deleted 
items folder.  Click Yes if you want to permanently delete all items.  Click No to 
cancel the process. 
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Alternatively: You can also permanently delete all the items from the Deleted 
Items folder by click the Tools menu and selecting Empty “Deleted 
Items” Folder. 

Contacts folder 
The Contacts folder is your e-mail address book and information storage for the people 
and businesses you communicate with.  The Contacts folder is used to store e-mail 
addresses, street addresses, phone numbers, and any additional information that relates to 
the contact, such as birthday or anniversary date. 

 
The Contacts Information Viewer 

When you enter a name or address for a contact, Outlook separates the name or address 
into parts and puts each part in a separate field.  You can sort, group, or filter contacts by 
any part of the name or any part of the address you want.  You can file contact 
information alphabetically under last name, first name, company name, or any word that 
helps you find the contact quickly.  Outlook gives you several naming choices to file the 
contact under, or you can enter your own choice.  

Creating a New Contact 
Information about each contact is saved as a Contact item.  Each Contact item can 
contain different fields of information.  Although Outlook can save as much or as little 
information about your contacts as you want, it is usually only necessary to complete a 
few of the fields for each contact. 

1. Click the Contacts shortcut icon  on the Outlook Shortcuts Bar to display 
the Contacts Information viewer. 
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2. Click New .  A new Untitled-Contact form appears. 

 
A new contact form 

3. The General tab is where you type most of the information about the contact.  All 
fields, except Full Name or Company, are optional. 

4. Type in the name of the contact in the Full Name… field.  You can either type the 
name in the field as “firstname lastname” or “lastname, firstname” (without the 

quotes) or click Full Name…  and type the name in the five specific 
fields.   

5. If appropriate, type the person’s job title in the Job title: field.   

6. In the Company: field, type the name of the company the person is associated with.   

7. When you tabbed, the File as: field is automatically filled in with the name entered in 
the Full Name… field.  This field is responsible for alphabetizing the contact name in 
the Contacts Information viewer.  Contact information can be filed by last name, first 
name, nickname, or any word that helps you find the contact quickly.  Outlook gives 
you several naming choices to file the contact under, or you can enter your own 
choice. 

8. In the next four fields, Business, Home, Business Fax and Mobile fields, you can type 
in phone numbers for the contact.   

9. By default, Outlook expects you to type a Business address.  Type the complete 
address in the large text field at the right of the Address… field. 

10. In the blank box next to the E-mail field, type in an email address if desired.  

11. In the Web page address: field, type in the contact’s Web page address. 

Note: It is not necessary to type http://, Outlook automatically adds it 
when you tab to the next field. 
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12. The large, blank area at the bottom of the form is for miscellaneous notes about the 
contact. 

13. Each contact can be associated with other contacts.  Click Contacts… to display the 
Select Contacts dialog box and select one or more contacts. 

14. Click Categories… to display the Categories dialog box and assign one or more 
categories to a Contact. 

15. If you intend to share the contents of your Contacts folder with other people, but you 
do not want them to view the information regarding this contact, click the Private 
field. 

16. When you have entered all the information you need regarding this contact, click 
Save and Close.  

The default view for Contacts is Address Cards, which shows you each contact as an 
individual card with one mailing address, one business telephone number, one home 
telephone number, one email address, and one Web page address.  Change the view in 
Contacts by clicking the View menu, pointing on to Current View, and then selecting one of 
the views from the menu.   

Creating a Contact from an email message you receive 
You can quickly add a person to your Contact list from an email message.  It does not 
matter whether the name is in the To:, From:, or CC:, field. 

1. Open the email message. 

2. In the From:, To:, or Cc: field, right-click any name you want to make into a contact. 

3. From the submenu, select Add to Contacts.  A new Contact form appears. 

4. The Full Name…, File as:, and E-mail fields are automatically filled in with 
information about that person.  You may add any additional information you wish or 
leave it alone with just this information. 

5. Click Save and Close. 

6. Repeat steps 2-5 as needed to add additional contacts on this email message. 

7. Close the email message. 

8. Open the Contacts folder to view the person you just added. 

Creating a Personal Distribution List 
If you send email regularly to the same group of people, you can create a personal 
distribution list for that group.  Future emails can then be addressed to the personal 
distribution list and will be sent to all members. 

1. Open the Contacts folder, if it isn’t already. 

2. Click the Actions menu and select New Distribution List.  An Untitled – 
Distribution List form appears. 
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A new distribution list 

3. Type a name for the distribution list in the Name: field. 

4. To add names to the distribution list, do one or both of the following: 

• To add names from either the Global Address List or your Contacts folder, click 
Select Members….  The Select Members dialog box appears.  By default, the 
Global Address List is displayed in the Show Names from the: field.  You can 
select a contact from this list or change the field to show your Contacts and select 
names from there.  Select a contact you want in the distribution list and click 
Members->.  The name should be listed under the Add to distribution list: 
section.  When you have selected all the names you want in the distribution list, 
click OK. 

Tip: If you want to select everyone in your department, click Find….  In 
the Department: field, type the name of your department.  When the 
search is done, select all entries and click Members-> to move the 
names over to the Add to distribution list: field.  Click OK. 

• To add names and email addresses of people who are not currently in your 
Contacts folder or on the Global Address List, click Add New….  In the Display 
Name: field, type the contact’s name.  In the E-mail address field, type the 
contact’s email address.  If you check the Add to contacts field, that person will 
be added to your Contacts folder as a separate contact, as well as the personal 
distribution list.  Click OK. 

5. Repeat step 4 as many times as needed to add all the contacts you want to the 
distribution list. 

6. Click the Notes tab to add notes to yourself about this distribution list. 

7. When you have all the people added to the distribution list that you want, click Save 
and Close. 

The name of the personal distribution list is now in your Contacts folder.  It is identified 
by an icon of a pair of heads near the right end of a card’s title.  
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Editing a Personal Distribution List 
1. Open the Contacts folder, if it isn’t already. 

2. Double-click the personal distribution list’s name. 

3. You can: 

• Add more people to the personal distribution list by clicking either Select 
Members… or Add New…. 

• Remove people from the personal distribution list by selecting the name you 
want to remove and clicking Remove. 

• Update the personal distribution list.  If the Global Address List has been updated 
or you have made changes to items in your Contacts folder since you created the 
list, click Update Now to update the personal distribution list (i.e., if someone’s 
email address changes). 

4. Click Save and Close to save the changes. 

Creating an Exchange Distribution List 
Exchange Distribution Lists are a convenient way to include groups of people when using 
messaging, calendaring, and Public Folder features of Outlook.  A Distribution List 
which is hosted on the Exchange server differs from a "Personal Distribution List" which 
you might create in your own Contacts folder in a couple of important ways.  

• The list can be accessible to others through the Global Address Book.  

• The membership of the list will be updated automatically on a nightly basis.  

• The list can be easily used to assign permissions to a Public Folder.  

Each Exchange Distribution List is highly configurable and can be maintenance-free for 
Exchange users.  A list can be made of the faculty and staff employed in a certain 
department or of all the students enrolled in a certain class.  As information changes in 
Human Resources and Student Records, the lists are automatically updated nightly so 
they will always match the most current data.  

The options available for list creation are too numerous to list here. If you'd like to read 
more about what lists can do and what kind of lists you can request for your department, 
class, or University organization, please see the Exchange Distribution List Overview 
document online at http://www.ku.edu/exchange/dlists/dlistsoverview.shtml.  

To request an Exchange Distribution List, go to http://www.ku.edu/exchange/dlists. 

Quitting Outlook 
To shut down Outlook, click the File menu and select Exit or click the close button.  

Note: If you open either an existing item or a new item and then close 
Outlook without closing the item, the open item remains displayed on 
the desktop.  You can close the item displayed on the desktop by 
clicking the close button. 
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Changing your password 
Password changes must be made online.  You can change your Exchange password 
through the KU Online Services Password Management 
(http://www.ku.edu/computing/password) page if you also want to change dial-in, 
People, etc.  You are no longer able to change your password through Outlook or 
Outlook Web Access (OWA).   

For More Information 
Here are some additional sources of information about Outlook and Exchange: 

KU’s Exchange & Outlook Support – 864-0200 

Exchange Email Help – exchange@ku.edu 

Email your questions, problems or concerns to the Exchange team. 

Website FAQs – www.ku.edu/exchange/faqs.shtml 

Questions and information related to KU’s Exchange project and using the Outlook client 
can be located at this Web site. 

Other Help Options -  

Like other Microsoft Office applications, Outlook has a Help menu and an Office 
Assistant that can be used to get online help.  Selecting Help from the Help menu allows 
you to use the Office Assistant or the Outlook Help file to find the information you need.  
You can also use the What’s This feature to find out about a part of the Outlook window 
or what a button or box does.  All of the following features can be located under the Help 
menu on the toolbar. 

Using the Office Assistant -- When you first start Outlook, the Office Assistant appears 
on your screen.  You can choose any of the items listed in the Office Assistant balloon.  
You can also type a question and click Search.  The Office Assistant provides a list of 
relevant topics.  If you select a topic, the Office Assistant opens a window that provides 
detailed information about that topic.  The Office Assistant can be hidden or closed. 

Using the on-line help -- The Help window has two panes.  The left pane allows you to 
select topics and the right pane shows information about the select topics.  There are three 
tabs: Contents, Answer Wizard, and Index.  The Contents tab allows you to select general 
areas of information, the Answer Wizard tab allows you to ask a question in your own 
words, and the Index tab provides an alphabetical list of major help topics. 

What’s This? -- When you select this option from the Help menu, a question mark is 
added to the pointer.  Using this question mark pointer, you can point onto any menu item 
and click to get information about that item, or point onto any region of an Information 
viewer or form and click to get information about that region. 

Office on the Web -- Outlook opens Internet Explorer and opens a Web site with 
information about Office 2000 applications. 

Detect and Repair -- Activates a utility that examines your Office installation and 
automatically corrects errors. 
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Getting Additional Help 
Academic Computing Services provides consulting and Q&A help in a variety of ways: 

785/864-0200 
question@ku.edu 
www.ku.edu/acs/help 

Last Update: 03/08/2004 


